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Safety Information
Important Information

NOTICE Read these instructions carefully, and look at the equipment to become familiar with 
the device before trying to install, operate, or maintain it. The following special 
messages may appear throughout this documentation or on the equipment to warn 
of potential hazards or to call attention to information that clarifies or simplifies a 
procedure.

The addition of this symbol to a Danger or Warning safety label indicates
that an electrical hazard exists, which will result in personal injury if the
instructions are not followed.

This is the safety alert symbol. It is used to alert you to potential personal
injury hazards. Obey all safety messages that follow this symbol to avoid
possible injury or death.

DANGER indicates an imminently hazardous situation, which, if not avoided, will 
result in death or serious injury.

DANGER

WARNING indicates a potentially hazardous situation, which, if not avoided, can result 
in death, serious injury, or equipment damage.

WARNING

CAUTION indicates a potentially hazardous situation, which, if not avoided, can result 
in injury or equipment damage.

CAUTION
33003805 06/2008 5



Safety Information
PLEASE NOTE Electrical equipment should be installed, operated, serviced, and maintained only by 
qualified personnel. No responsibility is assumed by Schneider Electric for any 
consequences arising out of the use of this material.

© 2008 Schneider Electric. All Rights Reserved.
6 33003805 06/2008



About the Book
At a Glance

Document Scope This document describes the Unity Loader stand-alone tool.

The Unity Loader transfers Unity Pro applications bidirectionally between a PC and 
an M340 PLC. It also transfers firmware (FW) mono-directionally from a PC to an 
M340 PLC.

You can download additional technical publications and other technical information 
from our website at www.telemecanique.com.

Validity Note The data and illustrations found in this document are not binding. We reserve the 
right to modify our products in line with our policy of continuous product 
development. The information in this document is subject to change without notice 
and should not be construed as a commitment by Schneider Electric.

User Comments We welcome your comments about this document. You can reach us by e-mail at 
techpub@schneider-electric.com
33003805 06/2008 7
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Unity Loader General Information
At a Glance

Overview This chapter comprises general information about the Unity Loader and the 
dedicated hardware platform M340. 

What's in this 
Chapter?

This chapter contains the following topics:

Topic Page

General 10

Installation 11

Cautions and Preconditions 12
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General Information
General

Overview The Unity Loader is a stand-alone software tool dedicated to the M340 hardware 
platform. A Unity Pro license is not required to use the loader.

The Unity Loader software provides the following transfer features:

transfer of a Unity Pro application from a PC to a PLC
transfer of a Unity Pro application from a PLC to a PC
transfer of firmware (FW) from a PC to a PLC or to a module with firmware

Note: The Unity Loader software requires one of the following operating systems:
Windows Professional Edition 32
Windows XP
Windows Vista Professional Edition 32
10 33003805 06/2008



General Information
Installation

Overview Insert the CD Unity Loader in the CD-ROM drive.

Autorun launches the setup automatically. If not, double-click Setup.exe.

The Unity Loader Installation Wizard will guide you through the installation.
33003805 06/2008 11



General Information
Cautions and Preconditions

Before FW 
Transfer

PLC in Stop 
Mode

Stop the PLC before you start firmware (FW) transfer.

If you do not stop the PLC before trying to transfer firmware (FW), you will be 
informed by the Unity Loader that the PLC must be stopped.

After confirming this message, the Unity Loader will stop the PLC automatically.

Note: Save the PLC program and other data before transferring firmware (FW) 
from a PC to a PLC or to a module with firmware.

RISK OF UNINTENDED EQUIPMENT OPERATION

Before transferring data to a PLC make sure that you have selected the correct 
project and firmware files and entered the correct target address. Verify the 
address by comparing the MAC address printed on the device with the MAC 
address shown in the Firmware tab.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.

WARNING
12 33003805 06/2008
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Communication
Target Devices

Overview The Unity Loader target devices are as follows:

processors (CPUs) of the Modicon M340 platform
Ethernet modules of the Modicon M340 platform
other modules (with firmware) of the Modicon M340 platform

Run/Stop 
Command

The Unity Loader can send a run or stop command to the processor.

RISK OF UNINTENDED EQUIPMENT OPERATION

Before starting/stopping a PLC make sure that you are connected to the correct 
target address. Verify the address by comparing the MAC address printed on the 
device with the MAC address shown in the Firmware tab.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.

UNKNOWN OPERATIONAL STATE OF EQUIPMENT

Evaluate operational state of equipment before starting or stopping a PLC. 
Hazardous situations can occur if system state is not confirmed prior to starting or 
stopping a PLC.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.

WARNING

WARNING
13



Communication
Communication CPUs are accessible through their USB or Ethernet ports
Ethernet modules are accessible through their own Ethernet port (crossover 
cable, point to point)
Other modules (with firmware) of the Modicon M340 platform are accessible 
through the CPU (connection on a CPU port).
These modules can not be accessed through Ethernet modules.
14 33003805 06/2008
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Unity Loader Dialog Box
At a Glance

Overview This chapter comprises information about the tabs of the Unity Loader dialog box.

What's in this 
Chapter?

This chapter contains the following topics:

Topic Page

General Description of the Dialog Box 16

Project Tab 22

Firmware Tab 29

Save on Memory Card 33

Options Tab 37

About Tab 39

Scan Network Dialog Box 41

Transferring Data Dialog Box 43
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Unity Loader Dialog Box
General Description of the Dialog Box

Overview The user interface of the Unity Loader is a dialog box with 4 different tabs: 

Project tab
transfer of a Unity Pro application (program, data, user files) from a PC to a PLC 
or vice versa
Firmware tab
transfer of firmware (FW) from a PC to a PLC or to a module with firmware
Options tab
general settings for the Unity Loader
About tab
information about your Unity Loader (version, copyright, etc.)

Transfer FW or 
Transfer Project

RISK OF UNINTENDED EQUIPMENT OPERATION

Before transferring data to a PLC make sure that you have selected the correct 
project and firmware files and entered the correct target address. Verify the 
address by comparing the MAC address printed on the device with the MAC 
address shown in the Firmware tab.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.

WARNING
16 33003805 06/2008



Unity Loader Dialog Box
Start PLC / 
Stop PLC

Launching the 
Unity Loader

Launch the Unity Loader via Start → Programs → Schneider Electric → 
Unity Loader.

RISK OF UNINTENDED EQUIPMENT OPERATION

Before starting/stopping a PLC make sure that you are connected to the correct 
target address. Verify the address by comparing the MAC address printed on the 
device with the MAC address shown in the Firmware tab.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.

UNKNOWN OPERATIONAL STATE OF EQUIPMENT

Evaluate operational state of equipment before starting or stopping a PLC. 
Hazardous situations can occur if system state is not confirmed prior to starting or 
stopping a PLC.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.

WARNING

WARNING
33003805 06/2008 17



Unity Loader Dialog Box
General 
Structure

The following areas are included in each of the 4 tabs:

tab selection (at the top of the dialog box)
tab specific area
Connection
Memory Card
command buttons (at the bottom of the dialog box)

After launching the Unity Loader, the dialog box will open with the Project tab. 

Tab Selection To select a tab click the respective tab selector (Project, Firmware, Options, 
About).

Project Firmware Options About

.sta

PC Project

LD_FBName:

24.01.2006  10:26:30Last Build:
00.00.0000Version:

...

C:\Applications\LD_FB.dat

PC Project Data

Name:

Last Build:
From:

...

From:
Unlocated Data:

%M:
%MW:

To:
To:

C:\Applications\LD_FB.car

PC Project Files

...

User Web Files: Data Storage:

Enable Transfer

PLC Project

LD_FBName:

24.01.2006  10:26:30Last Build:
00.00.0000Version:

Enable Transfer

PLC Project Data

From:
From:

Unlocated Data:

%M:
%MW:

To:
To:

512
1024

0
0

Enable Transfer

PLC Project Files

User Web Files: Data Storage:

Connection

Media: Ethernet Address: 139.158.105.141 PLC: RUN

Memory Card

State: Free Space:

Scan... Disconnect PC <=> PLC Transfer Stop PLC Close

Yes

Yes

Yes

Unity Loader 1.0

Ok 30.324
18 33003805 06/2008



Unity Loader Dialog Box
Tab Specific 
Area

The content of the tab specific area depends on the individual tab. For more 
information see the respective tab description.

Project tab (see Project Tab, p. 22)
Firmware tab (see Firmware Tab, p. 29)
Options tab (see Options Tab, p. 37)
About tab (see About Tab, p. 39)

Connection The connection area comprises the following elements:

Element Description

Media This list box displays one of the 2 PC ports:
USB (default)
Ethernet

To select a PC port click the arrow and select the respective port in the list.

Address: This list box displays the address of the target device e.g. SYS or 
139.158.105.141 (Ethernet).
To select another address click the arrow and select the respective 
address in the list or type the address you want to connect to.

PLC: This box indicates the state of the PLC:
RUN
STOP
HALT
LOADING
NOCONF
ERROR

Note: Devices are addressed by TCP/IP addresses or through point-to-point 
connection via USB (default). The address can either specify a CPU or an Ethernet 
module.
33003805 06/2008 19



Unity Loader Dialog Box
Memory Card The memory card area comprises the following elements:

The following data are stored in the file system partition of the memory card:
User Web Files (CPUs with Ethernet and NOEs)

the Factory Cast default Web site
potentially custom web pages
some user files relative to the Web site

Data Storage (CPUs only)
user files managed by the application with the file management function blocks 
or
files transferred by the user with FTP

Firmware (FW)
files transferred by the Unity Loader for FW upgrade

Element Description

State: This box indicates the state of the memory card installed in the connected 
PLC:

OK
Absent
Read only

Free Space: This box indicates the free space available on the memory card file system 
partition of the connected PLC.

Note: To transfer firmware (FW) to PLC, a memory card must be installed in the 
PLC because the FW is temporarily stored on the memory card.

Note: The Free Space shown for Memory Card is relative to the whole file system 
partition. Please refer to the memory card characteristics to see what is the 
maximum size that can be allocated to the user files. FW update will not be possible 
in case of insufficient free space.
20 33003805 06/2008



Unity Loader Dialog Box
Command 
Buttons

The text of some buttons changes depending on the actual situation (e.g. Connect/
Disconnect). Grayed buttons are disabled.

The command button area comprises the following buttons:

Help Button

Button Description

Scan... Click this button to open the Scan Network dialog box. Network scanning is 
used to detect IP addresses available in the network. For more information see 
Scan Network Dialog Box, p. 41.

Connect / 
Disconnect

Click this button to connect/disconnect the Unity Loader to/from the selected 
PLC.

PC<=>PLC Click this button to select the data transfer from PC to PLC or from PLC to PC, 
depending on the selected transfer direction. The current transfer direction is 
indicated by transfer signs (arrows) in the tab specific area of the Project tab 
and the Firmware tab. The transfer direction can only be selected for all 3 
transfer signs (arrows) at the same time.
Note: It is not possible to transfer the FW from PLC to PC. For the Firmware 
tab the PC<=>PLC button is disabled.

Transfer Click this button to start the transfer between the PC and the PLC or from PLC 
to PC depending on the preselected transfer direction. The Transferring data 
dialog box opens (see Transferring Data Dialog Box, p. 43).

Start PLC / 
Stop PLC

Click this button to start/stop the PLC. See Safety Message in the following 
paragraph.

Close Click this button to close the Unity Loader dialog box.
The Close button is disabled during transfer.

Note: There is no Help button available in the dialog box. To launch online help 

press F1 or click the  button in the title bar.
33003805 06/2008 21



Unity Loader Dialog Box
Project Tab

Overview This tab comprises the following services:
project transfer

transfer of a Unity Pro application from a PC file (*.STU, *.STA, *.STM) to a 
PLC
transfer of a Unity Pro application from a PLC to a PC file (*.STA, *.STM)

project data transfer
save application data values from a PLC to a PC file (*.DAT)
restore application data values from a PC file (*.DAT) to a PLC

project files transfer
save user files (data storage files and/or user files in the embedded Web site) 
from a PLC to a PC file (*.CAR)
restore user files from a PC file (*.CAR) to a PLC

Main Parts The specific area of the project tab consists of 2 main parts:

PC Project properties on the left specify the content of the files stored on the PC.
PLC Project properties on the right specify the current status of the files stored on 
the connected PLC.

The transfer signs (arrows) between the 2 property areas indicate the transfer 
direction and significant comparison results between PC project and PLC project.
22 33003805 06/2008



Unity Loader Dialog Box
Representation After launching the Unity Loader, the dialog box will open with the Project tab. 

Project Operating System Options About

.sta

PC Project

LD_FBName:

24.01.2006  10:26:30Last Build:
00.00.0000Version:

...

C:\Applications\LD_FB.dat

PC Project Data

Name:

Last Build:
From:

...

From:
Unlocated Data:

%M:
%MW:

To:
To:

C:\Applications\LD_FB.car

PC Project Files

...

User Web Files: Data Storage:

Enable Transfer

PLC Project

LD_FBName:

24.01.2006  10:26:30Last Build:
00.00.0000Version:

Enable Transfer

PLC Project Data

From:
From:

Unlocated Data:

%M:
%MW:

To:
To:

512
1024

0
0

Enable Transfer

PLC Project Files

User Web Files: Data Storage:

Connection

Media: Ethernet Address: 139.158.105.141 PLC: RUN

Memory Card

State: Free Space:

Scan... Disconnect PC <=> PLC Transfer Stop PLC Close

Yes

Yes

Yes

Unity Loader 1.0

Ok 30.324
33003805 06/2008 23



Unity Loader Dialog Box
PC Project 
Properties

The PC Project section consists of the following elements:

Element Description

PC Project The list box at the top displays the current project file with its path.
To select a prior transferred project file click the arrow and select the 
respective project file.

To select any other project file click the ... button ( ). This opens the 
dialog box Select application file where you can select the desired 
Unity Pro project file.
Further project file information:

Name: name of the Unity Pro project (default is STATION)
Last Build: date and time of the last Unity Pro project build
Version: version of the Unity Pro project

PC Project Data The list box at the top displays the current project data file with its path.
To select a prior transferred project data file click the arrow and select 
the respective project data file.

To select any other project data file click the ... button ( ). This opens 
the dialog box Select a data file where you can select the desired 
Unity Pro project data file.
Further project data file information:

Name: name of the Unity Pro project data file
Last Build: date and time of the last Unity Pro project build
%M: located variables (bits)
%MW: located variables (words)
Unlocated Data: data of function blocks and application

PC Project Files The list box at the top displays the current project files archive with its 
path.
To select a prior transferred project files archive click the arrow and 
select the respective project files archive.

To select any other project files archive click the ... button ( ). This 
opens the dialog box Select a storage file where you can select the 
desired Unity Pro project files archive.
Note: The project files archive (*.CAR) is a backup file only and can not 
be edited with other tools.
The following files are stored as parts of the *.CAR file, if existent on the 
PLC.

User Web Files: user web files stored on the memory card of the 
PLC
Data Storage: user files stored on the memory card of the PLC via 
special function blocks
24 33003805 06/2008



Unity Loader Dialog Box
PLC Project 
Properties

The PLC Project section consists of the following elements:

Enable Transfer 
(Check Boxes)

The specific area of the project tab provides the possibility to transfer 3 different 
parts of a Unity Pro project:

project (*.stu, *.sta, *.stm)
project data (*.dat)
project files (*.car)

By default all parts are selected, which allows a transfer of a complete project in one 
operation.

Each part of a project can be excluded from transfer by clearing the respective 
Enable Transfer check box. A deselected part is grayed and its transfer sign (arrow) 
is red and crossed out.

Even for excluded parts the available information is displayed to provide the context 
information.

Element Description

PLC Project Enable Transfer see below.
Project file information:

Name: name of the Unity Pro project (default is STATION)
Last Build: date and time of the last Unity Pro project build
Version: version of the Unity Pro project

PLC Project Data Enable Transfer see below.
Project data file information:

Name: name of the Unity Pro project data file
Last Build: date and time of the last Unity Pro project build
%M: located variables (bits)
%MW: located variables (words)
Unlocated Data: data of function blocks and application

PLC Project Files Enable Transfer see below.
The following files are stored as parts of the *.CAR file, if existent on the PLC.

User Web Files: user web files stored on the memory card of the PLC
Data Storage: user files stored on the memory card of the PLC via special function blocks

Note: For the following reasons, the check boxes are disabled and the color of the 
arrows is switched to red:

invalid files (e.g. files not created with Unity, but with valid extension)
PLC in NOCONF state (not configured)
33003805 06/2008 25



Unity Loader Dialog Box
Transfer Signs 
(Arrows)

Transfer signs (arrows between the PC´s and PLC´s property areas) indicate:

the transfer direction
significant comparison results between the PC and the PLC projects

The transfer direction can be changed by clicking the PC<=>PLC button. The 
transfer direction can only be changed for all 3 signs (arrows) at the same time.

Comparison 
Results

Comparison is only done for transfer from PC to PLC.

The comparison results are represented by different colors of the arrows:

Green indicates that these parts of the PC and the PLC projects are compatible.
Yellow indicates that these parts of the projects are compatible but errors may 
occur.
Red indicates that these parts are not compatible. In this case the transfer sign is 
additionally crossed out.

Transfer from 
PLC to PC

If you transfer a project from PLC to PC the appropriate boxes at PC side (PC 
Project, PC Project Data, PC Project Files) are filled automatically by the 
Unity Loader.

If a history exists for the selected project, the boxes are filled with historic input.
For new projects the names are generated from the Default backup directory 
(to be set on the Options tab) and the project name on PLC.
If, for example, the project name on PLC is Motor_01 and the default backup 
directory is C:\Applications, the following names will be generated:

PC Project: C:\Applications\Motor01.sta
PC Project Data: C:\Applications\Motor01.dat
PC Project Files: C:\Applications\Motor01.car

Note: If the Unlocated Data part is not compatible with the project embedded 
inside the PLC, only the located variables (%M, %MW) are transferred. A warning 
message is displayed and the arrow color switches to yellow.

Note: For transferring a project from PLC to PC no comparison is done and 
therefore color indication is not available. If you try to transfer a file that already 
exists, you have to confirm to overwrite it.
26 33003805 06/2008



Unity Loader Dialog Box
Entering File 
Names

The dialog box supports you in entering file names:

If you already specified names, the respective boxes are automatically filled with 
historic input.
If you enter new names in 1 of the list boxes, a proposed entry is automatically 
entered in the next list box. Example: If you enter C:\Applications\Motor_01.stu  
in the PC Project box and you click the empty PC Project Data box afterwards, 
it will automatically be filled with C:\Applications\Motor_01.dat. You can confirm 
this proposal or overwrite it.

File Format  

To transfer a project from PC to PLC you can select a file in one of the three formats.

The Unity Loader will save a project, transferred from PLC to PC in *.STA or *.STM 
format, depending on the project settings in Unity Pro (Upload Information Include/ 
Without Upload Information). See table below.

Upload Information Included

File 
Format

Description Comment

*.STU Unity Pro project file complete project including source code and Unity Pro workspace data

*.STA Unity Pro archive file complete project including source code but without Unity Pro workspace data
This archive file is very compressed.

*.STM Unity Loader specific 
project file

binary project data only, required for execution on PLC
It contains no source code and can therefore not be read by Unity Pro. 
Note: This file format can be used to backup the PLC project data.

Unity Pro  Unity Loader  PLC

Via Tools → Project Settings → 
Build the checkbox Upload 
Information Included is 
selected.
A project is saved/archived in 
*.STU or *.STA format

-> Such a binary project can be 
transferred to PLC with the 
Unity Loader.

-> The binary project runs on the PLC.

Such a file in *.STA format can be 
opened with Unity Pro (but 
without the former workspace 
data.)

<- Such a binary project can be 
transferred from PLC to PC with 
the Unity Loader and is saved in 
*.STA format.

<- The binary project runs on the PLC.
33003805 06/2008 27



Unity Loader Dialog Box
Without Upload Information

For detailed information about *.STA format and Upload Information please refer to 
the Unity Pro Operating Modes Manual.

File Format After 
Online 
Modification

Online modifications of a project via Unity Pro can result in *.STM file format.

In Unity Pro you built a project with the checkbox Upload Information Included 
selected.
With the Unity Loader you transferred such a binary project to PLC.
With Unity Pro you online modified the program in the PLC.
(The upload information is no longer up-to-date).

Now you try to disconnect the PLC from Unity Pro and a dialog box informs you, 
that the upload information is not up-to-date.
If you confirm to update the upload information (with Yes) it is updated.
If you negate to update the upload information (with No) it is not updated.
Trying to transfer such a not updated project from PLC to PC with the 
Unity Loader, you will be informed that the upload information is not up-to-date 
and the project will be stored in *.STM format.

Unity Pro  Unity Loader  PLC

Via Tools → Project Settings → 
Build the checkbox Without 
Upload Information is selected.
A project is saved/archived in 
*.STU or *.STA format

-> Such a binary project can be 
transferred to PLC with the 
Unity Loader.

-> The binary project runs on the PLC.

Such a file in *.STM format can 
not be opened with Unity Pro.

<- Such a binary project can be 
transferred from PLC to PC with 
the Unity Loader and is saved in 
*.STM format.

<- The binary project runs on the PLC.

- - A file in *.STM format can be 
transferred from PC to PLC with 
the Unity Loader.

-> The binary project runs on the PLC.

Note: To save space on the PLC, the checkbox Without Upload Information 
should be selected.

Note: Either Unity Pro or the Unity Loader can be connected to a PLC at the same 
time.
28 33003805 06/2008



Unity Loader Dialog Box
Firmware Tab

Overview This tab comprises the following services:
immediate firmware (FW) upgrade (or downgrade) of the target device (CPU, 
NOE or other modules with firmware)
generating a memory card to be used later for firmware upgrade of another PLC

Main Parts The specific area of the Firmware tab consists of 2 main parts:

PC firmware properties on the left specify the content of the files stored on the 
PC.
PLC firmware properties on the right specify the content of the files stored on the 
PLC.

The transfer sign (arrow) between the 2 property areas indicates the transfer 
direction and significant comparison results between PC and PLC firmware (FW).

Precondition To transfer firmware (FW) to a PLC, a memory card must be available at the PLC 
because the firmware is temporarily stored on the memory card.

Note: It is not possible to transfer FW from PLC to PC.
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Unity Loader Dialog Box
Representation Firmware tab 

PC FW 
Properties

The PC firmware (FW) properties area consists of the following elements:

Unity Loader 1.0

Project Firmware Options About

PC

...

PLC

MAC Address:

Connection

Media: Ethernet Address: 139.158.105.141 PLC: RUN

Memory Card

Free Space:

Scan... Disconnect Transfer Stop PLC Close

Device Version Description Device Version Description

30.324

Save on Memory Card Module

State: Ok

PC <=> PLC

...0.6

Element Description

PC The list box at the top displays the selected FW file with its path.
To select a prior transferred FW file click the arrow and select the 
respective FW file.

To select any other FW file click the ... button ( ). This opens the dialog 
box Select a Firmware File where you can select the desired FW file.
Further information:

Device: name of the device
Version: version of the FW
Description: description of the FW
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Unity Loader Dialog Box
PLC FW 
Properties

The PLC firmware (FW) properties area consists of the following elements:

Firmware (FW) 
Information

There may be more than 1 FW to be displayed and compared for 1 device. This 
information is displayed in additional rows.

By default, main information (device name and version) is displayed. Use the 
horizontal scroll bar to display the entire information.

Position the mouse pointer on a listed FW to display all related information (tool tip).

Firmware (FW) 
File

The FW file (*.ldx) is a zip file that contains:

a script for the Unity Loader defining the information and the way it will be 
transferred
several FW parts for each device, which have to be kept consistent

So you have to select only 1 file to guarantee consistency.

MAC Address The MAC address is displayed for Ethernet devices.

This helps you to identify the device more securely.

The MAC address is not available for intelligent modules (see below).

Hardware ID The hardware ID must match. If not, the transfer sign is marked red and crossed out. 
Transfer is disabled.

FW Version The firmware (FW) version to be transferred should be later than the current one. If 
not, the transfer sign is marked yellow.

Transfer Sign 
(Arrow)

Transfer sign (arrow between the PC´s and PLC´s property areas) indicates:

the transfer direction
significant comparison results between the PC´s and the PLC´s FW

Element Description

PLC Device: name of the device
Version: version of the FW
Description: description of the FW
MAC Address: MAC address of the PLC
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Unity Loader Dialog Box
Comparison 
Results

Comparison is only done for transfer from PC to PLC.

The comparison results are represented by colors:

Green indicates that the FWs of the PC and the PLC are compatible.
Yellow indicates that the FW of the PC is earlier than the FW of the PLC.
Red indicates that the FWs are not compatible. In this case the transfer sign is 
additionally crossed out.

FW Partial 
Transfer

If not all parts inside the selected firmware (FW) file (*.ldx) are compatible, the Unity 
Loader offers a partial download of the compatible FW parts.

A warning message is displayed that must be confirmed before partial download.

FW Transfer from 
PLC to PC

It is not possible to transfer the FW from PLC to PC.

In the Firmware tab the PC<=>PLC button is disabled.

Addressing 
Modules

The Module check box enables you to upgrade other modules (with firmware) of the 
Modicon M340 (e.g. BMX ART 0414).

Restrictions for 
Upgrading 
Modules

The following restrictions apply to the upgrading modules feature:
This feature is not applicable to Ethernet modules. Ethernet modules can be 
upgraded by direct connection only (same as for CPUs).
After upgrading a module (with firmware), the FW version displayed in 
Unity Loader is not refreshed automatically.
To display the FW properties after upgrading you must perform a hardware reset 
of the PLC by pressing the reset button of the power supply or by power cycling 
the PLC.
After upgrading a module (with firmware) by using the Save on Memory Card 
feature, you must perform a hardware reset of the PLC by pressing the reset 
button of the power supply or by power cycling the PLC (else the module remains 
blocked in a non operational state).

Save on Memory 
Card

Please refer to Save on Memory Card, p. 33.

Step Action

1 Activate the Module check box to display Rack.Slot of the device connected via Ethernet (e.g. 0.6).

2 Click the ... button right beside the Module check box to open the Module Address dialog where you can 
enter Rack Index and Slot Index of the module you want to upgrade.

3 Enter Rack Index and Slot Index and subsequently clicking OK.

4 Now you can upgrade the specified module.
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Unity Loader Dialog Box
Save on Memory Card

Overview The Save on Memory Card feature provides the possibility to generate a memory 
card that can be used later for firmware (FW) upgrade of another PLC.

As an upgrade by means of the memory card does not require the presence of Unity 
Loader, this option could be useful to upgrade PLCs that can not be connected to 
the Unity Loader directly.

Save on Memory 
Card Unchecked

By default Save on Memory Card is unchecked.

The Unity Loader sends a request to upgrade the PLC immediately after the 
firmware (FW) is transferred to the memory card.

All FW files are stored only temporarily on the memory card and will be removed 
after upgrade is completed.

Save on Memory 
Card Checked

If Save on Memory Card is checked, the unzipped firmware (FW) files are 
transferred to the memory card of the PLC.

The files are marked for automatic upgrade.

At the end of the transfer you are asked to perform a manual reset of the PLC.

A reset will upgrade the FW of the PLC automatically, if the current version of the 
PLC is earlier than the version on the memory card and the FW on the memory card 
is compatible to FW on the PLC.

The files related to FW will be removed after upgrade.

Source/Target 
PLC

You can use a memory card for firmware (FW) upgrade of another PLC.
Source PLC
On the source PLC you generate a memory card, remove it from the PLC and 
send it to the target PLC (e.g. to another site/country).
Target PLC
On the target PLC you insert the memory card and upgrade the FW.

Note: As it is not possible to display the data on the memory card, it is 
recommended to label the card after saving FW on the card.

Note: The memory card must remain on the target PLC.
33003805 06/2008 33



Unity Loader Dialog Box
Upgrading a PLC 
with Memory 
Card

To upgrade the target PLC using the memory card, created at the source PLC, 
proceed as follows:

Only 1 FW on 
Memory Card

Only 1 firmware (FW) can be saved on a memory card.

Each transfer, whether Save on Memory Card is checked or not, will erase the FW 
folder first.

Memory Card 
Write Protect

Addressing 
Modules

For addressing modules (with firmware) please refer to Addressing Modules, p. 32.

Step Action

1 Check Save on Memory Card and start the transfer.
Result: 

The unzipped firmware (FW) files are transferred to the memory card of the 
PLC.
The files are marked for automatic upgrade.

2 Remove the memory card from the source PLC.

3 Insert the memory card to the target PLC.

4 Perform a manual reset at the target PLC.
Result:

The firmware (FW) of the target PLC is upgraded automatically, if the current 
version of the PLC is earlier than the version on the memory card and the FW 
on the memory card is compatible to FW on the PLC.

Note: 
The files on the memory card related to FW are removed after upgrade.
Note: 
The memory card must remain on the target PLC.

Note: If the memory card is write protected, it is not possible to perform an upgrade 
using the memory card.
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Unity Loader Dialog Box
Project on 
Memory Card

If there is a memory card present at a Modicon M340 and you transfer data using 
the Project tab of the Unity Loader, the following data are stored on the memory 
card for backup reasons:

Project (Unity Pro application)
Project Files

Data Storage files
User Web Files 

Project and FW 
at Once

If you transferred data to a memory card (on the Project tab) as described above 
and you are using the Save on Memory Card feature on the Firmware tab, both 
data are present at the memory card.

Inserting the memory card into another PLC and performing a manual reset, the 
project and the FW are updated.

The memory card must remain on the target PLC.

Note: Other user files (like Word, Excel, Adobe) and Project Data (%M, %MW, 
values of unlocated data) are not stored on the memory card.

Note: It is also possible to upgrade a project only without upgrading the firmware 
(FW).

Note: Take care to have the appropriate project on the memory card.
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Unity Loader Dialog Box
One Shot/Multi 
Shot

For using the memory card there are 2 modes:
One shot
With the one shot mode, you need 1 memory card for 1 upgrade.
Multi shot
With the multi shot mode, you can use a memory card, generated on a source 
PLC, to update several target PLCs (for Unity Pro applications only).

For the possible use cases of the memory card please refer to the table below.

Area Description One Shot Multi Shot

System Area
(Firmware tab)

1 firmware (FW) (including 
Web pages if available)

Need 1 memory card per 
FW and per machine.

not supported
(The system removes all upgrade 
information after upgrade).

User´s Area
(Project tab)

Project (Unity Pro 
application)

No need to provoke a 
backup, the new memory 
card remains in the PLC.

You need to provoke a backup.

Data Storage files The new memory card 
remains in the PLC.

not supported

User Web Files 

other user files (like Word, 
Excel, Adobe) 

Project Data (%M, %MW, 
unlocated data)

not supported not supported
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Unity Loader Dialog Box
Options Tab

Overview The Options tab comprises a set of general settings for the Unity Loader.

Representation Options tab 

Unity Loader 1.0

Project Firmware Options About

C:\Applications

Settings

...

Connection

Media: Ethernet Address: 139.158.105.141 PLC: RUN

Memory Card

State: Free Space:

Scan... Disconnect PC <=> PLC Transfer Stop PLC Close

English

Default backup directory:

D:\UnityLoader\UL_Ftp.log ...FTP log file:

Language:

30TCPIP transmission timeout: s

View Clear

D:\UnityLoader\UL_Event.log ...Event log file: View Clear

Ok 30.324
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Unity Loader Dialog Box
Settings  

Transfer Button In the Options tab the Transfer button is disabled.

Element Description

Default backup 
directory:

backup directory for Unity Loader files (e.g. C:\Applications)
The default backup directory and the project name on the PLC are used to 
generate new project names (including path) automatically while 
transferring a project from PLC to PC.
See Transfer from PLC to PC, p. 26.

FTP log file: name and path of the FTP log file
In this file, requests and replies exchanged between the loader´s FTP 
client and the PLC´s FTP server are logged.
Click the View button to look at the log file.
Click the Clear button to empty the log file.

Event log file: name and path of the event log file
In this file, all major events, such as FW transfer, PLC start / stop or 
unexpected events (errors) are logged.
Click the View button to look at the log file.
Click the Clear button to empty the log file.

Language: This list box displays the languages provided for the Unity Loader user 
interface.

English
French
German
Italian
Spanish
Chinese

To switch to another language click the arrow and select the respective 
language in the list.
Note: After switching to another language you have to close and launch 
again the Unity Loader.

TCPIP 
transmission 
timeout:

delay used for failure recovery while TCP/IP transmission (seconds)
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Unity Loader Dialog Box
About Tab

Overview The About tab comprises information about your Unity Loader:

version
build
copyright information
license agreement
registration information

Representation About tab 

Unity Loader 1.0

Project Firmware Options About

Registration informations

Connection

Media: Ethernet Address: 139.158.105.141 PLC: RUN

Memory Card

State: Free Space:

Scan... Disconnect PC <=> PLC Transfer Stop PLC Close

Company:

User name:

Unity Loader 1.0 (Build 5.12.16.0)

Copyright © 2005 Schneider Automation SAS

Part Number:

Warning
This software is protected by copyright law and by international conventions. Any reproduction or distribution of the 
software in whole or in part, by any means is strictly prohibited.

Any person not respecting these provisions will be guilty of the offense of fraud and will be liable to penalties provided 
for by the law.

Telemecanique
a brand of
Schneider

Electric

Unity

L
o

ad
er

Ok 30.324

Register now

License agreement

This product is registered to:
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Unity Loader Dialog Box
License 
Agreement

Click the License agreement button to display the license agreement for your 
Unity Loader software.

Register Button Click the Register now button to register your Unity Loader software.

Transfer Button In the About tab the Transfer button is disabled.
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Unity Loader Dialog Box
Scan Network Dialog Box

Overview Clicking the Scan... button opens this dialog box.

Network scanning helps you to detect IP addresses of M340 PLCs in the network.

The Scan Network dialog box is modeless, i.e. the dialog box does not keep the 
input focus so scanning can be done in parallel.

Representation Scan Network dialog box 

IP Range Specify the range of IP addresses, in which hosts should be searched after clicking 

the Start scan button. You can also click the auto-detect button ( ). to fill in the 
maximum range of the PC´s network segment.

Unity Loader - Scan Network

139.158.105.118

Cancel scan Pick address Close

2 node(s) found

...IP range: 139.158.105.110 To:

IP Address Host Name devices

139.158.105.141

MAC Address
PLC_001 BMX P34 202000-00-54-12-69-6F139.158.105.111
PLC_002 BMX P34 202000-00-54-12-69-71139.158.105.113
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Unity Loader Dialog Box
IP Address 
Properties

The IP Address properties comprise the following elements:

Command 
Buttons

The text of some buttons changes depending on the actual situation (e.g. Start Scan 
/ Cancel Scan). Grayed buttons are disabled.

The command button area comprises the following buttons:

If the Unity Loader is connected the Pick address button is disabled.

Element Description

IP Address IP address found in the network

Host Name host name of the found IP address

MAC Address MAC address of the found IP address

devices device assigned to the found IP address

Button Description

Start scan / 
Cancel scan

Click this button to start/cancel network scan.
The status of the scan process is displayed above the command buttons.

Pick address Click this button to fill the IP address of a selected host into the address box 
of the main dialog box. See Connection, p. 19.

Close Click this button to close the Scan Network dialog box.
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Unity Loader Dialog Box
Transferring Data Dialog Box

Overview Clicking the Transfer button opens this dialog box.

The Transferring data dialog box displays a status report of the data transfer.

The dialog box is modal, i.e. you cannot return to the previous dialog box until the 
Transferring data dialog box is closed.

RISK OF UNINTENDED EQUIPMENT OPERATION

Before transferring data to a PLC make sure that you have selected the correct 
project and firmware files and entered the correct target address. Verify the 
address by comparing the MAC address printed on the device with the MAC 
address shown in the Firmware tab.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.

RISK OF UNEXPECTED EQUIPMENT BEHAVIOR

If the update failed (for example, if there was a power off of the PLC during the 
process), the PLC is in an undetermined state. In this case restart the transfer 
immediately to bring the PLC again in a defined state.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.

WARNING

WARNING
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Unity Loader Dialog Box
Representation Transferring data dialog box 

Transferring data to PC

Abort

Application upload started
Transfer completed
Project data upload started
Transfer completed

Close
3,784 of 3,784 bytes transferred
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Unity Loader Dialog Box
Status 
Information

For application transfer the Transferring data dialog box comprises the following 
status information:

transfer started
number of bytes transferred
transfer completed

A status bar displays the transfer status.

For firmware (FW) transfer the Transferring data dialog box comprises the 
following status information:

transfer started
free space on memory card
required space
available space
directory information
transfer completed
writing files to flash memory
FW upgrade successful

A status bar displays the transfer status.

Required Space The amount of required space is a little bit larger than the data that should be 
transferred, because the firmware (FW) needs additional space for file 
management.

Available Space The value of available space may be larger than the Free Space value displayed in 
the Memory Card status line because the calculation of available space takes into 
account the memory space of data that will be overwritten by new data.

Command 
Buttons

Grayed buttons are disabled.

Note: The Transferring data dialog comprises only the main events. For detailed 
information please refer to the log files (Options Tab, p. 37).

Button Description

Abort Click this button to abort the transfer.

Close Click this button to close the Transferring data dialog box.

Note: During firmware (FW) transfer the Abort and the Close buttons are disabled.
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Example: Transfer of an 
Application from PC to PLC
Transfer of an Application from PC to PLC 
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Example: Transfer of an Application from PC to PLC
Procedure The following table describes the procedure for transferring a Unity Pro application 
from a PC to a PLC.

Step Action

1 Connect the PC and the PLC to the network.

2 If you do not know the required IP addresses click the Scan... button. (See Scan 
Network Dialog Box, p. 41).

3 Enter the connection data: Media and Address. (See Connection, p. 19).

4 Click the Connect button. (See Command Buttons, p. 21).

5 Select the required project files (PC Project, PC Project Data, PC Project Files). 
(See PC Project Properties, p. 24).

6 Set/reset the required Enable Transfer check boxes. (See Enable Transfer (Check 
Boxes), p. 25).

7 If necessary set the transfer direction to PC->PLC by clicking the PC<=>PLC button. 
(See Command Buttons, p. 21) and Transfer Signs (Arrows), p. 26).

RISK OF UNINTENDED EQUIPMENT OPERATION

Before stopping the PLC make sure that you connected to the correct target 
address. Verify the address by comparing the MAC address printed on the device 
with the MAC address shown in the Firmware tab.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.

Step Action

8 Click the Stop PLC button. (See Command Buttons, p. 21).

9 Click the Transfer button. (See Command Buttons, p. 21).
Result: The Transferring data dialog box opens and displays a status report of the 
data transfer. (See Transferring Data Dialog Box, p. 43).

10 After transfer is completed, close the Transferring data dialog box and click the Start 
PLC button

WARNING
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Appendices
At a Glance

Overview This chapter comprises information about drivers.

What's in this 
Appendix?

The appendix contains the following chapters:

Chapter Chapter Name Page

A USB Driver 51

B Memory Card Driver 61

C Transfer of Applications in Batch Mode 63
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USB Driver
At a Glance

Overview This chapter describes USB driver installation. This installation procedure can be 
broken down into two steps:

installation of files on the station,
configuration of the driver.

What's in this 
Chapter?

This chapter contains the following topics:

Topic Page

How to install the driver 52

Finalizing the Installation 55

State of the USB link 57
51



USB Driver
How to install the driver

At a Glance Driver installation is a standard installation. It can be launched either:

from the drivers' CD-ROM,
or from disks if the station has no CD-ROM drive.

How to create a 
set of disks

Use the following procedure to create installation disks:

Note: The installation disks are created from the CD-ROM.

Step Action

1 Use a station which has a CD-ROM drive.

2 Insert the CD-ROM into the drive.

3 Access the directory of the driver to be copied onto disk.

4 Copy the contents of the DISK1 directory onto a disk. Repeat this step for each DISK 
directory.
Note: it is advisable to number the disks.
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USB Driver
Checks When using Windows Professional Edition 32, Windows XP or Windows Vista 
Professional Edition 32, you must check whether it is possible to install unsigned 
drivers on the station.

To do this, perform the following actions:

Step Action

1 Right-click on My Computer and select Properties.

2 In the System Properties window, select the Hardware tab.

3 Press Driver Signing Options....
The following window is displayed: 

4 Select Warn - Display..., then confirm by clicking OK.

 Cancel OK 

 Verification of file signatures

To ensure their authenticity, all files of the Windows 2000 CD-ROM are 
protected by a digital signature and automatically checked during the installation 
process.

When you install a new software, the following verification parameters
will be used

Ignore: installs all files, regardless of their signatures

Warn: displays a warning message before installing an unsigned file

Forbid: prevents the installation of unsigned files

Define parameters as default parameters

Pilot signature option ?

 Administrator option
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USB Driver
How to install the 
driver

Before starting the installation, check that the USB cable is not connected to the 
PLC.

To install the driver, carry out the following procedure: 

Start of installation

Installation by
CD-ROM?

Insert CD-ROM in CD-ROM drive

Insert the 1st disk in the drive

Appearance
of the file 

INSTALL.HTM
?

Click on the link which corresponds 
to the driver to be installed

Access the directory of the driver 
to be installed corresponding to 

the PC's operating system

Access the directory DISK1

Double click on the file 
SETUP.EXE

Yes

Yes

No

No

Choose Run this program from 
its current location then confirm 

by clicking on OK

Click on Next

Configure the driver then close the 
configuration screen

End of installation

Restart the computer

Choose Yes in the security warning 
screen
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USB Driver
Finalizing the Installation

Procedure After rebooting  the PC you will have to configure the USB driver. The USB cable 
must be connected to the PLC, and then Windows will detect the PLC and install the 
driver.

Perform the following actions:

Step Action

1  The following screen will be displayed: 

2 Click on YES 

USB Device

New Hardware Found

Digital Signature Not Found

NoYes More Info

The Microsoft digital signature affirms that software has been 
tested with Windows and that the software has not been altered 
since it was tested.

The software you are about to install does not contain a 
Microsoft digital signature. Therefore, there is no guarantee that 
this software works correctly with Windows.

PLC USB Device

If you want to search for Microsoft digitally signed software, visit 
the Windows Update Web site at http://
windowsupdate.microsoft.com to to see if one is available.

Do you want to continue the installation?
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USB Driver
3 An icon is displayed in the task bar. Double clicking on it when the USB link with the 
PLC is operational calls up the window. 

Clicking on  " Driver Manager " launches the tool.
Clicking on  "OK" makes an icon appear in the task bar.

Step Action

Driver Manager

OK

General

Period            :             00.00.01

Status             :             On-line

PLC USB DriverUS

 Activity
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USB Driver
State of the USB link

At a Glance A window showing the state of the USB link can be accessed from the taskbar:

Start → Settings → Control Panel → Driver Manager

With Windows XP Professional Edition: Select the PLC USB Driver tab to 
display the following window: 

Description for Windows XP Professional Edition:

Field Description

Virtual Port Name of the COM port used by the driver.

Status Contains:
 "Running" if the driver is operating.
 "Not operational" if the driver is not operating.
 "Disconnected" if the USB cable is not connected.

Remote IP\Local IP IP addresses used by the PC and PLC to communicate.

 Log File Button allowing access to a *.log file containing connection/
disconnection events on the USB line.

Management Properties of SCHNEIDER drivers

PCX57 Driver FPC10 Driver FPP20 Driver MODBUS Test XWayTest
SCP114 DriverUNITELWAY DriverPLC USB DriverDRIVERS  Manager

USBPLC USB Driver V1.2 IE17

Copyright © 2005 Schneider Automation SAS

 Log File 

Virtual Port : COM8

Status : Running

Remote IP : 90.0.0.1

Local IP : 90.0.01

OK 
33003805 06/2008 57



USB Driver
With Windows Vista Business Edition 32: Select the PLC USB Driver  tab to 
display the following window 

To see Diagnostic (Screen below) press the more... button.

Virtual Port : COM5

SCHNEIDER drivers management Properties

XIP Driver MODBUS Test XWayTest
PLC USB Driver UNITELWAY DriverUSB-FIP Driver

USBPLC USB Driver V3.0 IE07

Copyright © 1999-2007, Schneider Automation SAS

 More... 

OK 

DRIVERS Manager
MODBUS SERIAL Driver
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USB Driver
With Windows Vista Business Edition 32: Select the PLC USB Driver diagnostic  

Description for Windows Vista Business Edition 32:

Field Description

Virtual Port Name of the COM port used by the driver.

Status Contains:
 "Running" if the driver is operating.
 "Not operational" if the driver is not operating.
 "Disconnected" if the USB cable is not connected.

Remote IP\Local IP IP addresses used by the PC and PLC to communicate.

 Log View Button allowing access to a *.log View containing connection/
disconnection events on the USB line.

Log view

PLC  USB Driver Diagnostic

USB

0: 2-5-2008  16h:37mn:20s:636ms-->USB OK

1: 2-6-2008  9h:10mn:13s:241ms-->Cable disconnected

2: 2-8-2008  11h:6mn:54s:169ms-->USB OK

OK 

Status        :       Running

Remote IP :       90.0.0.1

Local  IP    :       90.0.0.2 

Log view
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Memory Card Driver
Memory Card Driver

Overview The purpose of the memory card driver is to operate with the Modicon M340 memory 
card file system directly on a PC (read/write files) without using a FTP server.

Memory cards use a file system dedicated to embedded firmwares for reliability 
reason against power cuts (unlike a FAT file system for instance)

By default, the files are only visible in the CPU by means of an FTP server.

But it is possible to access the files on a memory card with a PC (Windows 
Professional Edition 32, Windows XP or Windows Vista Professional Edition 32) 
after a special driver has been installed.

Installing the 
Driver

Install the driver as described in the following table.

Note: The access through FTP or directly from a PC is restricted to user files 
located in the Data Storage folder.

Note: It is not possible to access the files on a memory card with a Linux PC or a 
MAC.

Step Action

1 Select the respective folder on the Unity Loader CD (...\memory card driver).

2 Right click the reliance.inf file and select Install in the context menu.

3 The driver is installed automatically.
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Memory Card Driver
Using the File 
System

Once the driver is installed, you can access the new file system.

Step Action

1 Insert a memory card in the card reader.

2 Select the respective folder in the Windows Explorer.
Result: The files are visible.

3 You can read, write, rename or delete files and folders like in a Windows file system 
for (e.g. FAT or NTFS).
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Transfer of Applications in Batch 
Mode
Batch Mode with the Unity Loader Command Line Interface

Overview The Unity Loader offers the command line interfaces UlUmas.exe for skilled users.

UlUmas.exe provides commands for transferring applications and data files via 
UMAS protocol.

The main usage is to transfer applications to 1 or several PLCs by calling a script 
without running Unity Loader dialogs but you can also start and stop PLCs.

Commands 
without 
Additional 
Checks

Transfer FW or 
Transfer Project

RISK OF UNINTENDED EQUIPMENT OPERATION

Before executing commands by means of the command line interface make sure 
that the commands will not result in hazardous situations for men or equipment.
The command line interface executes commands on the PLC without additional 
checks.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.

WARNING

RISK OF UNINTENDED EQUIPMENT OPERATION

Before transferring data to a PLC make sure that you have selected the correct files 
and entered the correct target address. Verify the address by comparing the MAC 
address printed on the device with the MAC address shown by Unity Loader in the 
Firmware tab.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.

WARNING
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Transfer of Applications in Batch Mode
Start PLC / Stop 
PLC

UMAS UMAS stands for Unified Messaging Application Service, a platform independent 
protocol for exchanging application data.

Program You can find the UlUmas.exe in the installation directory of your Unity Loader 
software.

Documentation You can find a detailed documentation (UlUmas.doc) in the installation directory of 
your Unity Loader software, too.

Running the 
Program

On your PC select Start → Run, enter UlUmas.exe in the Open dialog and confirm 
with OK.

RISK OF UNINTENDED EQUIPMENT OPERATION

Before starting/stopping a PLC make sure that you are connected to the correct 
target address. Verify the address by comparing the MAC address printed on the 
device with the MAC address shown in the Firmware tab.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.

UNKNOWN OPERATIONAL STATE OF EQUIPMENT

Evaluate operational state of equipment before starting or stopping a PLC. 
Hazardous situations can occur if system state is not confirmed prior to starting or 
stopping a PLC.

Failure to follow these instructions can result in death, serious injury, or 
equipment damage.

WARNING

WARNING
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